®

E stablished 1981

Advanced Test Equipment Rentals
www.atecorp.com 800-404-ATEC (2832)

AVTMTTR330-EN
Rev B
September 2008

Instruction Manual
for
Three-Phase TTR®
Transformer Turn Ratio Test Set
TTR330 series
Catalog Numbers. TTR330, TTR330-47

HIGH-VOLTAGE EQUIPMENT

Read this entire manual before operating.

M
Valley Forge Corporate Center
2621 Van Buren Avenue
Norristown, PA 19403-2329
U.S.A.
610-676-8500
www.megger.com

Three-Phase TTR®
Transformer Turn Ratio Test Set
TTR330 series

Copyright© 2007 by Megger. All rights reserved.
The information presented in this manual is believed to be adequate for the intended use of the product.
If the product or its individual instruments are used for purposes other than those specified herein,
confirmation of their validity and suitability must be obtained from Megger. Refer to the warranty
information below. Specifications are subject to change without notice.
WARRANTY
Products supplied by Megger are warranted against defects in material and workmanship for a period of
one year following shipment. Our liability is specifically limited to replacing or repairing, at our option,
defective equipment. Equipment returned to the factory for repair must be shipped prepaid and insured.
Contact your MEGGER representative for instructions and a return authorization (RA) number. Please
indicate all pertinent information, including problem symptoms. Also specify the serial number and the
catalog number of the unit. This warranty does not include batteries, lamps or other expendable items,
where the original manufacturer’s warranty shall apply. We make no other warranty. The warranty is
void in the event of abuse (failure to follow recommended operating procedures) or failure by the
customer to perform specific maintenance as indicated in this manual.
M
Valley Forge Corporate Center
2621 Van Buren Ave
Norristown, PA 19403-2329
610-676-8500 (Telephone)
610-676-8610 (Fax)
www.megger.com

Table of Contents
1. Getting to know the TTR330 ............................................................................................................................1
Product Overview ................................................................................................................................................1
User Interface Panel.............................................................................................................................................4
Communications ports ........................................................................................................................................5
HOME Action Icons...........................................................................................................................................5
Utility Icons...........................................................................................................................................................6
2. Safety .....................................................................................................................................................................7
Safety is the responsibility of the user ...............................................................................................................7
Input Power precautions .....................................................................................................................................8
3. PREPARING FOR TEST ................................................................................................................................9
Site Preparation.....................................................................................................................................................9
Making Circuit Connections ...............................................................................................................................9
4. Connecting to the Transformer...................................................................................................................... 11
Single-Phase, Two-Winding Transformers.................................................................................................... 11
Three-Phase, Two-Winding Transformers.................................................................................................... 14
Three-Phase, Three-Winding Transformers ................................................................................................. 15
Current Transformers (CTs)............................................................................................................................ 16
BCTs Mounted on Three-Phase Transformers ............................................................................................ 19
T-Type Transformers ....................................................................................................................................... 22
5. Operation........................................................................................................................................................... 23
Power up............................................................................................................................................................. 23
Navigating the screen........................................................................................................................................ 23
HOME Screen Action Icons ........................................................................................................................... 23
Remote Control Operation for LTC Testing................................................................................................ 27
Error Messages .................................................................................................................................................. 27
Upon completion of TEST – Powering down ............................................................................................. 28
6. Service ................................................................................................................................................................ 31
Maintenance ....................................................................................................................................................... 31
Fuse Replacement ............................................................................................................................................. 31
Calibration .......................................................................................................................................................... 32
TTR330 – Self check ........................................................................................................................................ 32
Troubleshooting ................................................................................................................................................ 34
Repairs................................................................................................................................................................. 35
7. Replacement Parts List and Optional Accessories ...................................................................................... 37
8. Specifications..................................................................................................................................................... 39
Electrical ............................................................................................................................................................. 39
Environmental Conditions............................................................................................................................... 41
Physical Data...................................................................................................................................................... 41
Addendum A TTR 300 Series PowerDB Lite User Manual ........................................................................... 43

AVTMTTR330-EN Rev B Sept 2008

i

List of Figures
TTR330 Transformer Turn Ratio test set............................................................................................................iii
Figure 1-1

Top Panel Controls .......................................................................................................................3

Figure 1-2.

User Interface Panel......................................................................................................................4

Figure 1-3.

Communications ports .................................................................................................................5

Figure 1-4.

HOME Action Icons ....................................................................................................................5

Figure 1-5.

Utility Icons ....................................................................................................................................6

Figure 4-1.

Setup for Testing Single-Phase Transformer ..........................................................................12

Figure 4-2.

Setup for Testing Single-Phase Autotransformer...................................................................12

Figure 4-3.

Setup for Testing Single-Phase, Type A (Straight Design) Step Voltage Regulator ..........13

Figure 4-4.

Setup for Testing Single-Phase, Type B (Inverted Design) Step Voltage Regulator.........14

Figure 4-5.

Setup for Testing Unmounted Current Transformer ............................................................17

Figure 4-6.

Setup for Testing Taps on Multiple Tap CT...........................................................................18

Figure 4-7.

Setup for Testing BCT Mounted on Single-Phase Two-Winding Transformer ................19

Figure 4-8.

Setup for Testing BCT Mounted on Delta Winding on a Three-Phase Power
Transformer .................................................................................................................................20

Figure 4-9.

Setup for Testing BCT Mounted on Wye Winding of a Three-Phase Transformer.........21

Figure 5-1

New Test Form screen ...............................................................................................................24

Figure 5-2

Three Phase QUICK test Screen ..............................................................................................25

Figure 5-3

File Manager -Recall Test...........................................................................................................25

Figure 5-4.

File Manager –SAVE Test screen .............................................................................................26

Figure 5-5

Global Settings – Preferences screen .......................................................................................26

List of Tables
Table 4-1.

Test Lead Markings for Single-Phase Transformers...................................................................13

Table 4-2.

Test Lead Markings for Three-Phase Transformers...................................................................15

Table 4-3.

T-type Transformer Winding Phase Relationship.......................................................................22

Table 6-1.

Troubleshooting Guide...................................................................................................................34

Table 7-1.

Replacement Parts List....................................................................................................................37

AVTMTTR330-EN Rev B Sept 2008

ii

Upon Receipt of Product
Prior to operation, check for loosened hardware or damage incurred during
transit. If these conditions are found, a safety hazard is likely, DO NOT attempt
to operate equipment. Please contact Megger as soon as possible.

TTR330 Transformer Turn Ratio test set
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Getting to know the TTR330
Product Overview
The Three-Phase TTR® Test Set is fully automatic, self-checking, menu-driven
unit. The test set measures the turn ratio, phase shift, and excitation current of
power, distribution, and instrument transformers. A “-47” suffix added to the
catalog number denotes a 230-V input power supply, rather than the standard
120-V supply. The test set is a portable instrument housed in a sturdy plastic case
with removable lid and carrying strap. The inside lining of case is metal shielded.
A canvas carrying bag is supplied to hold all accessories.
The test set can be used to test single-phase and three-phase transformers, both
with and without taps in accordance with the requirements of the IEEE
C57.12.90 – 1997 standards. For three-phase measurements, the test set is
connected to all three phases of the transformer to be tested. The TTR lead
selection circuitry permits automatic measurement of all phases without changing
connections. This feature eliminates the need to refer to hook-up charts when
testing three-phase transformers. Turn ratio, phase shift and excitation current
readings are displayed on a large LCD. Transformer excitation current as well as
phase shift angle helps to detect transformer shorted turns or an unequal number
of turns connected in parallel. Operating condition (error) messages identify
incorrect test connections, abnormal operating condition, or winding problems.
Test results can be saved either to internal memory, to an external USB storage
device, or can be uploaded to a personal computer (PC) via an ethernet port.
Features include:


Fully automatic operation.



Self-checking at power-up.



User-friendly, menu-driven operation.



Test turn ratio, phase shift (in both degree and centiradian), and excitation
current.



Easy measuring of regular windings, tertiary windings, and CTs.



Storage capacity to handle over 1000 test files (depending on size).
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Checking reverse polarity at start of each test.



Via ethernet port, an external PC or laptop can be connected to operate the
TTR (in remote control mode) or to transfer test results and to provide full
transformer test report.



Quick test mode provides the fastest testing of a transformer.



Three excitation test voltages: 80 V, 40 V, and 8 V.



Testing to ANSI, IEC, and Australian standards.



Leads marked to ANSI, IEC, and Australian standards.



Multi-lingual support.



Large, easy-to-read, full VGA color display



Meets the requirements of both the European EMC and Low Voltage
Directives.

It is recommended that the user becomes familiar with the TTR330 before ever
connecting to a transformer.
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Top Panel Controls

Figure 1-1. Top Panel Controls

1. Power input receptacle, ON/OFF switch, and fuse holder. ON/OFF power
switch and input power receptacle provides power to the test set.
2. Emergency OFF switch. This red push button interrupts testing. When
pressed, the switch is locked in off position. To reset the switch, twist the
button in the direction indicated by the arrows.
3. Voltage ON light. Red indicator lamp indicates when lit that test voltage is
being supplied to the Unit Under Test (UUT).
4. Remote Trigger receptacle. Plug receptacle for connecting Remote Trigger
cable for testing transformers with Load-Tap-Changers.
5. H – Cable receptacle. Plug receptacle for connecting test leads to the highvoltage (H) winding of a transformer
6. X – Cable receptacle. Plug receptacle for connecting test leads to the lowvoltage (X) winding of a transformer.
7. Ground lug. Wing-nut terminal allows connection of test set to Station
Earth ground.
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User Interface Panel
Test Button:

Initiates and Terminates Testing

Navigation Keys:

Use Arrow keys to highlight a desired Selection. Use
Enter button (in center) to Activate the Selection.

Home Key:

Toggles HOME Action Icons

Zone Key:

Allows User to select Active area of the screen.

Keypad:

Key board for entering notes and data.

Power Suspend:

Prepares the Instrument for Shutdown. A message will
indicate when Input Power can be safely removed (not
used on some models)

Help Function:

Provides on screen Help to assist operator.

Information Key:

Provides on screen information to assist operator

Function Key:

Displays the options available for any highlighted
Selection (when applicable)

Figure 1-2. User Interface Panel
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Communications ports

Ethernet port

USB Storage/Print
Figure 1-3. Communications ports

HOME Action Icons
Select to create NEW test

Select to RECALL test

Select to SAVE Test.

Select to ZOOM-IN

Select to ZOOM-OUT

Print Icon. Prints the Selected Test Form. Printer driver is factory installed. Please
contact Megger for specific printer model availability.

Select to enter PREFERENCES screen

Figure 1-4. HOME Action Icons
AVTMTTR330-EN Rev B Sept 2008
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Utility Icons
Cancel Icon. Select to Cancel without Saving.

Delete Icon. Deletes the Selected File or Report.

Print Icon. Prints the Selected Report. Printer must be standard USB
supporting HP PCL protocol.

USB Out Icon. Select to Transfer Files or Reports from external USB
Memory Stick to the TTR.

USB In Icon. Select to Transfer Files or Reports from the TTR to the external
USB Memory Stick.

Back Icon. Select to return back to the previous screen.

Figure 1-5. Utility Icons
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Safety
Safety is the responsibility of the user
Only qualified and trained operators should operate the TTR330 system.
Operator must read and understand this entire Instruction Manual prior to
operating the equipment. Operator must follow the instructions of this
Instruction Manual and attend the equipment while the equipment is in use. In
the event of equipment malfunction, the unit should immediately be deenergized and returned to Megger for repair. The Safety precautions herein are
not intended to replace your Company’s Safety Procedures. Refer to IEEE 510 1983, IEEE Recommended Practices for Safety in High-Voltage and HighPower Testing, for additional information.
General Safety Precautions
The TTR330 and the Unit Under Test (UUT) should both be considered as
sources of instantaneously lethal levels of electrical energy. Observe the
following safety precautions:


Observe all safety warnings on the equipment. They identify areas of
immediate hazard that could result in injury or death.



Use this equipment only for the purposes described in this manual. Observe
strictly the Warning and Caution information provided in this manual



Treat all terminals of high-voltage power equipment systems as potential
electric shock hazards. Use all practical safety precautions to prevent contact
with energized parts of the equipment and related circuits.



Use suitable barriers, barricades, or warnings to keep persons not directly
involved with the work away from test activities.



Never connect the test equipment to energized equipment.



Do not use in an explosive atmosphere.



Use the grounding and connection procedures recommended in this manual.
Always disconnect test leads from power equipment before attempting to
disconnect them at the test set. The ground connection must be the first
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made and the last removed. Any interruption of the grounding connection
can create an electrical shock hazard.


Personnel using heart pacemakers should obtain expert advice on the
possible risks before operating this equipment or being close to the
equipment during operation.

Input Power precautions
This instrument operates from a single-phase, sine wave, power source. It has a
three-wire power cord and requires a two-pole, three-terminal (live, neutral, and
ground) type input source. The voltage to ground from the live pole of the
power source must be within the following rated operating voltage:
For Cat. No TTR330

120 V ±10%, single phase sine, 50/60 ±2 Hz

For Cat. No. TTR330-47 230 V ±10%, single phase sine, 50/60 ±2 Hz
The neutral pole must be at ground potential. Before making connection to the
power source, determine that the instrument rating matches the voltage of the
power source. The power input plug must be inserted only into a mating
receptacle with a ground contact. Do not bypass the grounding connection. Any
interruption of the grounding connection can create an electric shock hazard.
Determine that the receptacle is properly wired before inserting the plug.
For test sets energized with 230 V input (TTR330-47), the neutral terminal of the
input supply cord (white or blue lead) must be connected to the neutral pole of
the line power source. The ground terminal of the input supply cord (green or
yellow/green lead) must be connected to the protective ground (earth) terminal
of the line power source. The black or brown cord lead is the live (hot) lead.
The control circuits of the instrument are protected by two mains circuit fuses.
These fuses are located in the ON/OFF switch module and are replaceable by
the operator. To avoid electric shock and fire hazard, use only the fuse specified
in Sections 1 and 8, that is identical in respect to type, voltage rating, and current
rating. Refer to the Fuse Replacement procedure in the Service section.

F

WARNING
Before replacing the fuses, disconnect the
power input plug from the live power source.

AVTMTTR330-EN Rev B Sept 2008
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PREPARING FOR TEST
Site Preparation
Choose a location that meets the following conditions:


The location is as dry as possible.



There is no flammable material stored in the vicinity.



The test area is adequately ventilated.



Be sure all equipment is de-energized and all terminals of the UUT are
accessible. Erect suitable safety barriers to protect the operator from traffic
hazards and to prevent intrusion by unauthorized personnel. User provided
Warning lights are recommended.



Verify that the Local station ground is intact and has impedance continuity to
earth.

Making Circuit Connections
Connections should be made in the order as listed below.
1. Ground. Use the Megger supplied Safety Ground Cable 15 ft (4.6 m) to
connect the TTR330 Wing Nut Ground Terminal directly to Local Station
Earth ground. Ensure the Transformer chassis also has impedance
continuity to Local Station Earth ground potential.
2. Input Power Source Ground. Input Power Source Ground Terminal
should be less than 100 milliohms of impedance to Local Station Earth
Ground.
3. Connect the Input Power Cord. Before making this connection, Ensure
the Input Power Source meets the requirements as listed in Section 2 and
Specifications Section 8. Also make sure that the ON/OFF switch (Figure 11, No. 1) is in the OFF position. Connect the input power cable to the
TTR330 first, then to the power source. At this time, leave the ON/OFF
switch in the OFF position.
AVTMTTR330-EN Rev B Sept 2008
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4. Connect the Ethernet cable (optional). If the user chooses to operate the
TTR330 in a remote-control mode, using PowerDB PC software, then
connect the Ethernet cable between the TTR330 and the PC at this time.
5. Connect the Load-Tap-Changer cable (optional). If the user chooses to
operate the “Test button” of the TTR330 from a remote distance then,
connect the LTC cable at this time.
6. Connect the H and X leads (to the TTR330 end only at this time).
With the clamps disconnected from the UUT, connect the Bayonet Plug on
the Cable labeled “H” to the TTR panel connector also labeled “H”. Repeat
this process for the “X” labeled cable. Ensure each connector is securely
fastened using a clockwise rotation.
7. Connect the H and X clamps. With the ON/OFF Switch in the OFF
position, connect the H and X clamps in accordance with Section 4 as
appropriate for the specific transformer type and test to be conducted.

AVTMTTR330-EN Rev B Sept 2008
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Connecting to the Transformer
The setup and connection instructions included in Section 4 herein, pertaining to
ratio, polarity, and phase relation, assume that the transformer under test,
connections, and terminal markings comply with the requirements of ANSI
C57.12.70-1990 American National Standards Terminal Markings and
Connections for Distribution and Power Transformers. The H test leads of the
test set are the exciting (high voltage) leads (8 V, 40 V, or 80 V). The X test
leads are the low voltage leads.
When testing high-voltage transformers, caution must be used at all times and all
safety precautions followed. Read, understand, and employ all safety precautions
and circuit connections described in Sections 2 and 3 herein.

F

WARNING
Ensure that the transformer to be tested is completely
de-energized. Check every winding. Ensure that all
terminals of the transformer are disconnected from line
or load at the transformer. Connections to ground may
be left in place.

F

WARNING
For all testing as described herein, care shall be taken
to ensure any and all unused clamps shall be isolated
from each other, from ground, and from personnel.

F

WARNING
Except for CTs as described herein, never interchange
connections between the high- and low-voltage
transformer terminals. Failure to observe proper
connections will result in a safety hazard and may
result in damage to the test set or transformer.

Single-Phase, Two-Winding Transformers
Perform the following setup procedure for single-phase, two-winding
transformers:
1. With the ON/OFF Switch in the OFF position, make the circuit
connections as described in Section 3.

AVTMTTR330-EN Rev B Sept 2008
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2. Connect the H and X test cables to the respective H and X receptacles of the
TTR330. Make sure that the connectors are securely fastened (using
clockwise rotation) to the receptacles.
3. Connect the heavy-duty clamps marked H1 and H2 of the test lead to the
corresponding (high-voltage winding) terminals of the transformer under
test. Figures 4-1 and 4-2 show test setups for single-phase transformers.
Figures 4-3 and 4-4 show test setups for regulators.
4. Connect the heavy-duty clamps marked X1 and X2 of the test lead to the
corresponding (low-voltage winding) terminals of the transformer under test.
Figures 4-1 and 4-2 show test setups for single-phase transformers. Figures
4-3 and 4-4 show test setups for regulators.
5. On/OFF Switch. It is only after all of the above connections are safely
made and all safety precautions of sections 2 and 3 are satisfied, should the
On/OFF switch be turned to the ON position.

Figure 4-1. Setup for Testing Single-Phase Transformer

Figure 4-2. Setup for Testing Single-Phase Autotransformer

To test windings other than H1 – H2 and X1 – X2, ensure that the heavy-duty
clamp marked H1 is connected to the lower numbered terminal and H2 to the
AVTMTTR330-EN Rev B Sept 2008
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higher numbered terminal of the high-voltage winding. Similarly, X1 and X2
should be connected to the low-voltage winding.
Test lead markings for the ANSI, CEI/IEC, and Australian standards are as
shown in Table 4-1.
Table 4-1. Test Lead Markings for Single-Phase Transformers
Test Lead Marking

Transformer

Heavy-Duty
Clamp

Test Lead

ANSI

CEI/IEC

Australian

Terminal Voltage

Boot Color

Color Band

H1

1U

A2

High

Red

Red

H2

1V

A1

High

Red

Yellow

X1

2U

a2

Low

Black

Red

X2

2V

a1

Low

Black

Yellow

Figure 4-3. Setup for Testing Single-Phase, Type A (Straight Design) Step Voltage Regulator
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Figure 4-4. Setup for Testing Single-Phase, Type B (Inverted Design) Step Voltage Regulator

Three-Phase, Two-Winding Transformers
Perform the following setup procedure for three-phase, two-winding
transformers:
1. With the ON/OFF Switch in the OFF position, make the circuit
connections as described in Section 3.2.
2. Connect the H and X test cables to the respective H and X receptacles of the
TTR330. Make sure that the connectors are securely fastened (using
clockwise rotation) to the receptacles.
3. Connect the heavy-duty clamps marked H0, H1, H2, and H3 of the test lead
to the corresponding (high-voltage winding) terminals of the transformer
under test. Refer to Table 4-2 for test lead markings. With delta connected
windings, H0 is not used. With wye connected windings, a neutral
connection for H0 is normally available.
4. Connect the heavy-duty clamps marked X0, X1, X2, and X3 of the test lead
to the corresponding (low-voltage winding) terminals of the transformer
under test. Refer to Table 4-2 for test lead markings. With delta connected
windings, X0 is not used. With wye connected windings, a neutral
connection for X0 is normally available.
AVTMTTR330-EN Rev B Sept 2008
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5. On/OFF Switch. It is only after all of the above connections are safely
made and all safety precautions of sections 2 and 3 are satisfied, should the
On/OFF switch be turned to the ON position.

Table 4-2. Test Lead Markings for Three-Phase Transformers
Test Lead Marking

Transformer

Heavy-Duty
Clamp

Test Lead

ANSI

CEI/IEC

Australian

Terminal Voltage

Boot Color

Color Band

H0

1N

N

Neutral

Red

White

H1

1U

A2/A4

High

Red

Red

H2

1V

B2/B4

High

Red

Yellow

H3

1W

C2/C4

High

Red

Blue

X0

2N

N

Neutral

Black

White

X1

2U

a1/a2/a4

Low

Black

Red

X2

2V

b1/b2/b4

Low

Black

Yellow

X3

2W

c1/c2/c4

Low

Black

Blue

Note:

According to Australian standard, wye and delta transformer winding
connections have a numerical suffix of 1 and 2. The zigzag transformers
have a numerical suffix of 4. See Table A-3.

Three-Phase, Three-Winding Transformers
This type of transformers has primary, secondary, and tertiary windings. Primary
and secondary windings are tested as a regular three-phase, two-winding
transformer. To test tertiary winding, perform the following setup procedure:
1. With the ON/OFF Switch in the OFF position, make the circuit
connections as described in Section 3.2.
2. Connect the H and X test cables to the respective H and X receptacles of the
TTR330. Make sure that the connectors are securely fastened (using
clockwise rotation) to the receptacles.
3. Connect the heavy-duty clamps marked H0, H1, H2, and H3 of the test lead
to the corresponding terminals of the transformer under test. Refer to Table
4-2 for test lead markings. With delta connected windings, H0 is not used.
With wye connected windings, a neutral connection for H0 is normally
available
4. Connect the heavy-duty clamps marked X0, X1, X2 , and X3 of the test lead
to the corresponding tertiary (low-voltage winding) terminals (Y0, Y1, Y2,
AVTMTTR330-EN Rev B Sept 2008
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and Y3) of the transformer under test. Refer to Table 4-2 for test lead
markings. With delta connected windings, X0 is not used. With wye
connected windings, a neutral connection for X0 is normally available.
5. On/OFF Switch. It is only after all of the above connections are safely
made and all safety precautions of sections 2 and 3 are satisfied, should the
On/OFF switch be turned to the ON position.

Current Transformers (CTs)
Connections to CTs are made backwards compared to power or potential
transformers. The H terminals on the test set must be connected to the X
terminals on the CT; and the X terminals on the test set must be connected to
the H terminals on the CT.
NOTE:

F
G

Dots on the housing of the transformer are commonly used to identify
terminals of the same polarity.
WARNING
Failure to observe proper connections will result in a
safety hazard and may result in damage to the test set
or CT. Failure to observe voltage rating of low-current
X winding may result in damage to the CT.
CAUTION
Never use AUTO mode of operation when testing the
current transformers with the rated voltage below80 V
ac.

Most of the CTs are tested at 8 V ac excitation voltage.
NOTE:

Most of the current transformers are tested at 8 V ac excitation voltage.
Some current transformers with turn ratio of 100:5 and less get
saturated at 8V ac. They require lower excitation voltage for testing and
therefore can not be tested with the Cat.No TTR330. For this case, use
the TTR100 or TTR25.

Unmounted CTs
1. With the ON/OFF Switch in the OFF position, make the circuit
connections as described in Section 3.2.
2. Connect the H and X test cables to the respective H and X receptacles of the
TTR330. Make sure that the connectors are securely fastened (using
clockwise rotation) to the receptacles.
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3. As shown in Figure 4-5, connect the heavy-duty clamps marked H1 and H2
of the test lead to the respective X1 and X2 terminals of the CT. Note that
the H and X leads are connected in reverse as compared to the Single and
Three phase Transformer testing described in the previous sections.
4. As shown in Figure 4-5, connect the heavy-duty clamps marked X1 and X2
of the test lead to the respective H1 and H2 terminals of the CT. Ensure
correct polarity. Note that the H and X leads are connected in reverse as
compared to the Single and Three phase Transformer testing described in the
previous sections.

Figure 4-5. Setup for Testing Unmounted Current Transformer

AVTMTTR330-EN Rev B Sept 2008
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Figure 4-6 shows the setup for testing the taps on a multiple-tap CT.

Figure 4-6. Setup for Testing Taps on Multiple Tap CT

Bushing Current Transformer (BCT) Mounted on Single-Phase,
Two-Winding Transformer
A turn-ratio test can be performed on a BCT after it has been mounted on a
circuit breaker or power transformer entrance bushing. The test can be
performed without removal of the BCT from the equipment. Proceed as follows:
1. With the ON/OFF Switch in the OFF position, make the circuit
connections as described in Section 3.2.
2. Connect the H and X test cables to the respective H and X receptacles of the
TTR330. Make sure that the connectors are securely fastened (using
clockwise rotation) to the receptacles.
3. Using user supplied shorting jumper leads, short-circuit the winding on the
opposite voltage side of the power transformer core.
4. Connect the heavy-duty clamps marked H1 and H2 of the test leads to the
respective X1 and X2 terminals of the BCT as shown in figure 4-7.
5. Connect the heavy-duty clamp marked X1 to the power transformer terminal
on which the BCT is mounted and the X2 heavy-duty clamp to the terminal
on the opposite side of the power transformer winding (H2 side of BCT).
Check to make sure that the BCT is mounted with proper polarity with
AVTMTTR330-EN Rev B Sept 2008
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respect to power transformer entrance bushing and that connection polarities
are correct.

Figure 4-7. Setup for Testing BCT Mounted on Single-Phase Two-Winding Transformer

BCTs Mounted on Three-Phase Transformers
A turn-ratio test can be performed on all three BCTs using a single setup. Figure
4-8 shows how (to make the proper connections) when the BCTs are mounted
on a typical delta winding and Figure 4-9 shows how when mounted on a typical
wye winding.
1. With the ON/OFF Switch in the OFF position, make the circuit
connections as described in Section 3.2.
2. Connect the H and X test cables to the respective H and X receptacles of the
TTR330. Make sure that the connectors are securely fastened (using
clockwise rotation) to the receptacles.
3. Short-circuit all windings on the opposite voltage side of the power
transformer core using jumper leads.
4. Check to make sure that all BCTs are mounted with proper polarity with
respect to the power transformer entrance bushing. Ensure that all
connection polarities are correct. Make connections as shown in figure 4-8
AVTMTTR330-EN Rev B Sept 2008
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for delta winding configurations and figure 4-9 for wye winding
configurations.

Figure 4-8. Setup for Testing BCT Mounted on Delta Winding
on a Three-Phase Power Transformer
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Figure 4-9. Setup for Testing BCT Mounted on Wye Winding of a Three-Phase Transformer
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T-Type Transformers
T-type transformers represent a special type of thee-phase transformer. This
transformer may be tested as a single phase transformer. In this case, the jumpers
indicated in Table 4-3 should be applied to the appropriate terminals of the Ttype transformers. The TTR measured turn ratio should be compared to the
calculated turn ratio indicated in Table 4-3.
Table 4-3. T-type Transformer Winding Phase Relationship
Winding Connection
IEC
Vector
Group

High-Voltage
Winding (H)

Low-Voltage
Winding (X)

External
jumpers

T-T
0

Phase
tested

H1 -H2
X1 -X2

B

H1 – H3

H2 -H3

A

H1 – H3

X1 - X2

VH
3
•
VX
2

B

H2 – H3

X1 – X3

VH
2
•
VX
3

H2 -H3

A

H1 – H3

X1 – X3

VH
3
•
VX
2

X1 –X3

B

H2 – H3

X2 – X1

VH
2
•
VX
3

X1 – X3

Remarks

VH

H1 - H2

X1 -X2

X 1 - X2

Calculated
Turn Ratio

A

T-T
30
lag

T-T
30
lead

Winding Tested
HighLowVoltage
Voltage
Winding
Winding

VX

VH
VX
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Operation
Power up
Proceed only after reading and fully reading and understanding Sections 2, 3, and
4 herein, with particular attention on the Safety related precautions.
Once all Safety precautions are taken, and all circuit connections are made, then
the user may safely turn the ON/OFF switch to the ON position and operate
the test instrument as described herein.

F

EMERGENCY SHUTDOWN
For Emergency shutdown, Push red EMERGENCY OFF
button or toggle On/OFF switch to OFF.

On power up, a beep sounds, the test set performs a self-test check, and all
hardware and software variables are initialized.

Navigating the screen
Use Arrows keys to highlight desired action

Use ENTER key (in center) to select highlighted action

HOME Screen Action Icons
Select HOME key to display Action Icons
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Action Icons:

Select NEW TEST to open new form

Figure 5-1 New Test Form screen

Quick test: This setup provides a quick path for single phase transformer
testing. It requires minimum transformer nameplate information to be entered
before testing. The test results displayed do not include either the calculated ratio
(per nameplate) or ratio deviation values.
Full test: This setup requires entering main transformer nameplate
information. The FULL test is used for obtaining full test information of a
transformer. This setup may be saved and recalled later for future testing of the
same or similar type transformers.
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3-Phase QUICK test, example
Use Navigation keys

Arrows/ENTER)
to select winding
configuration,
then Press TEST

Figure 5-2 Three Phase QUICK test Screen

Select Recall to open test from memory (either internal or USB memory)

Use Zone Key to move
cursor to various zones
on display

Figure 5-3 File Manager -Recall Test
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Select SAVE to save test to memory

Figure 5-4. File Manager –SAVE Test screen

Select PREFERENCES to set global parameters

Figure 5-5 Global Settings – Preferences screen
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Owner:

User specified field

SN:

Serial Number of Test Instrument

Language:

Indicates displayed language

Save File Prefix:

All Saved files will begin with this prefix

Units:

Units of Measure setting

Type:

Transformer type convention

Test voltage:

Default test signal voltage level

Show Diagram Number: Allows Transformer type diagram number to be
shown on test form
Default form:

Indicates default form, upon power-up

Remote Control Operation for LTC Testing
Use the remote control mode of the TTR for load tap changer (LTC) testing.
The remote control mode provides two-way-communication between the
operator and the TTR, allowing you to stay close to an LTC, change taps, and
initiate the test routine.
Connect the hand-held control unit, Megger p/n 30915-220, to the Remote
Trigger Receptacle port of the TTR. The remote control unit pushbutton lamp
will illuminate.
Now an operator may come to the remote location, and set (for example), the
LTC to the desired position, and would then depress the remote control unit
pushbutton for a short time, then release it. The pushbutton lamp extinguishes
until the TTR is ready for the next test. When the current testing is complete, the
test results are automatically saved, the test ID is advanced to the next number,
the pushbutton lamp lights, and the TTR test set is ready for the next remote test

Error Messages
When an error message appears in the transformer test result screen indicating an
abnormal operating condition, verify the condition by taking a repeat
measurement before attempting to take any corrective action.
Open connections, wrong connections, open windings, shorted windings, high
resistance windings, other abnormal transformer problems, or a combination of
these may cause a large deviation from normal turn ratio or indicate an unusual
message. The unusual operating conditions may be caused by an abnormal
leakage reactance or capacitive coupling within the transformer windings. If
abnormal operating conditions occur during transformer testing, error messages
may appear (such as below) and may be accompanied by three short beeps.
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CHECK CONNECTIONS
This message indicates that the transformer is not connected to the test set. The
message may be caused by poor connection of one of the test leads, as well.
PHASE A (or B, or C) EXCITATION CURRENT TOO HIGH
This message indicates that excitation current exceeds 500 mA. Excitation
current can be reduced by using lower test voltages (40 V or 8 V).
TURNS RATIO TOO LOW, <0.8
This message shows that a transformer under test turn ratio is less than 0.8. The
TTR is not designed to test a transformer turn ratio under 0.8.
PHASE A (or B, or C) TURNS RATIO TOO HIGH
This message shows that a transformer under test turn ratio is higher than 10,000
(if 80 V or 40 V is used) or is higher than 4,000 (if 8 V is used). The message may
be caused by poor connection of one of the test leads, as well.
CHECK PHASE A (or B, or C) CONNECTIONS, REVERSED
This message is caused by incorrect connection of the H and X leads. The H and
X leads have either been reversed or the test transformer connections or
markings do not comply with the requirements of ANSI, IEC, or the Australian
standard. The message may be caused by wrong diagram number specified, as
well.
CHECK PHASE A (or B, or C) POLARITY
This message shows that the H or X test leads are incorrectly connected or the
test transformer connections or markings do not comply with the requirements
of ANSI, IEC, or the Australian standard.

Upon completion of TEST – Powering down
1. Upon completion of testing, press the
(Power Suspend) button on the
TTR330 to prepare the unit for shutdown. Then, once directed by the onscreen instruction, Switch the ON/OFF Switch to OFF.
2. Using an adequately grounded Safety Ground Stick, ground all exposed high
voltage connections. Then, while wearing the appropriately rated rubber
gloves, connect Safety Ground Jumpers from all exposed high voltage cable
terminals to Local Station Earth Ground. It is a good idea to leave the
jumpers in place for at least as long as the specimen was at test voltage.
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3. Remove the Test Instrument clamps from the Transformer, leaving the
Safety Ground Jumper in place to drain any stored charge.
4. Disconnect the Power Cord from the Input Power Source.
5. Lastly, disconnect the safety ground cable.
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Service
Maintenance
Maintenance should be performed only by qualified persons familiar with the
hazards involved with high-voltage test equipment. Read and understand
Sections 2, 3, 4, and 5 before performing any service.
The TTR330 requires only periodic inspection. Periodically, inspect all hardware
items, including the cable assemblies, to ensure all is in good condition.
The TTR330 may be cleaned periodically. In so doing, do not allow water to
penetrate panel holes. An all-purpose, household spray cleaner can be used to
clean the panel. Polish with a soft, dry cloth, taking care not to scratch the
display screen cover. Clean the cables and mating panel receptacles with
isopropyl or denatured alcohol applied with a clean cloth.

Fuse Replacement
The TTR330 is protected by two mains fuses. Fuse replacement is indicated if
the electronic circuits do not function. Refer fuse replacement to qualified
personnel only. To avoid electric shock and fire hazard, use only the fuses
specified on Instrument panel. Note that 2 spare fuses are included with each
TTR.

F

WARNING
Before replacing the fuses, disconnect the power input
plug from the live power source.

To replace fuse(s), proceed as follows:
1. Disconnect the power cord from the TTR test set.
2. Using a small flathead screwdriver, carefully pry out the fuse holder of the
input power module (item 1 of figure 1.1).
3. Remove and properly dispose of spent fuse(s).
4. Install new fuse(s) making sure to use the type specified on Instrument panel.
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5. Reinstall the fuse holder in its receptacle in the input power module. Connect
the power cord to the TTR test set and to an energized power source. If the
electronic circuits still do not function properly, contact the factory for
service.

Calibration
A complete performance and calibration check should be made at least once
every year. This will ensure that the TTR test set is functioning and calibrated
properly over the entire measurement range. The 3-phase TTR calibration is
performed on each new or repaired unit before sending it to a customer. There is
a special 3-phase TTR final calibration procedure which requires a NISTtraceable test equipment to be used. As a result of such calibration procedure,
each TTR test set may be NIST certified.
To check the 3-phase TTR calibration at a customer site or in the field, the
Megger Calibration Standard Cat.No550055 or equivalent standard should be
used. To perform a quick simplified calibration check, the Megger Calibration
Standard CatNo550555 may be used. The last standard has eleven switchable
turns ratio settings which cover the turns ratio range from 1:1 to 2000:1.

TTR330 – Self check
A customer may want to make sure that the test set is functioning properly
before testing a transformer. Traditionally, for the transformer turns ratio testers,
a customer performed this test by connecting H1-X1 and H2-X2 test leads. The
1:1 turns ratio was expected to be measured. Additionally, the displayed test
results were interpreted as a test set calibration check.
The 3-phase TTR test set is designed and optimized for the transformer turns
ratio testing. It uses a mixed analog-digital technique to provide the high accurate
readings of the tested transformer turns ratio. The test set measurement
approach is based on high impedance input and output transformer voltage
monitoring circuits. The high impedance of the monitoring circuits is optimized
for the accurate transformer turns ratio testing.
When performing a 3-phase TTR functional test, the H and X test leads
interconnect the input and output monitoring circuits without a transformer
being connected. Such connection cause an impedance mismatch and, as a result
of the mismatch, the displayed turns ratio reading is not exactly 1:1 as it may be
expected. A customer should be aware that a functional test is not a real
transformer turns ratio test. Due to the intrinsic and inevitable impedance
mismatching, the 3-phase TTR functional test readings may be from 0.9980 to
1.0020. The TTR functional test readings do not represent its calibration. It
simply shows that the TTR test set circuitry functions properly. To check the 3phase TTR calibration, a customer should use the Calibration Standards
mentioned in Calibration section of the manual.
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To perform a 3-phase TTR functional test proceed as follows:
1. Turn TTR test set power off.
2. Connect H1 lead to X1 lead, H2 lead to X2 lead, H3 lead to X3 lead, and H0
lead to X0 lead. Make sure the leads are properly connected and that H/X
pairs are not electrically in contact with each other.
3. Turn TTR test set power on.
4. After self-test is complete and a QUICK TEST
5. Enter transformer type DIAG 07 YNyn0.

F

WARNING
Do not continue functional test if the diagram type
DIAG 07 YNyn0 transformer type is not listed.
Keep the leads, which are energized, clear of ground,
and personnel, and each of the other lead-pair sets.

6. Start TEST
7. The readings for phases A, B, and C should be:
RATIO: 1.0000 ±0.0020
PHASE(min): 0 ±5
Iexc (mA): 0.0 to 0.5
8. If needed, (as identified on the Preference screen), perform the test
according to steps 1 through 7 for all the excitation voltages of 8V, 40 V,
and/or 80V. The readings should be the same as shown in step 7.
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Troubleshooting
The Troubleshooting Guide, Table 6-1, is arranged to help you evaluate the
reasons for TTR test set malfunction. The table lists possible test set
malfunctions which may be encountered during operation and lists possible
causes. Electronic circuit repairs should not be attempted in the field. Refer to
Repair section. Refer to Section 7 for a list of spare parts.
Table 6-1. Troubleshooting Guide

MALFUNCTION
Display stays blank after POWER switch is
turned on.
Error message:
 ANALOG OFFSET VOLTAGE
HIGH
and/or
 ANALOG GAIN OUT OF
TOLERANCE appears after self-test is
complete.
Red TEST VOLTAGE ON lamp does not
light on start of testing.

POSSIBLE CAUSE
 No service power.
 Defective line cord.
 Defective fuse(s).
 Defective display or electronics.
Out of tolerance condition(s) in
measurement circuit.





One of the following messages appear on the
test result screen.
 CHECK CONNECTIONS
 PHASE A (or B, or C) EXCITATION
CURRENT TOO HIGH;
 TURNS RATIO TOO LOW, <0.8; or
PHASE A (or B, or C) TURNS RATIO
TOO HIGH;
 CHECK PHASE A (or B, or C)
CONNECTIONS, REVERSED;
 CHECK PHASE A (or B, or C)
POLARITY
RATIO and/or Iexc (mA) readings erratic.














Defective lamp.
EMERGENCY TEST OFF switch
is not released.
Problem in measuring circuit.

Abnormal operating condition.
Incorrect setting of
TRANSFORMER TYPE in the
quick test setup or the full test setup
1 menus.
Incorrect connection of leads.
Defective test leads.
Incorrect marking of a transformer.
Problem in test specimen.
Problem in measuring circuit.
Defective test leads (open circuit,
poor connection).
Severe abnormal transient in service
power.
Problem in test specimen (poor
connection).
Problem in measuring circuit.
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Repairs
Any service or repair of this equipment should be performed only by qualified
persons who are aware of electrical hazards and the necessary precautions
required to prevent injury.
Megger offers a complete Repair and Calibration Service and recommends that
its customers take advantage of this service for routine maintenance or in the
event of any equipment malfunction.
In the event Service is required, contact your Megger representative for a product
Return Authorization (RA) number and shipping instructions.
Ship the product prepaid and insured and marked for the attention of the
Megger Repair Department. Please indicate all pertinent information, including
catalog number, serial number, and problem symptoms.
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Replacement Parts List and Optional Accessories
Table 7-1. Replacement Parts List

Item

Cat. No.

Three-phase Transformer Turns Ratio Test Set
120 V ac ±10%, single phase, 50 ±2 Hz or 60 ±2 Hz, 100 VA

TTR330

230 V ac ±10%, single phase, 50 ±2 Hz or 60 ±2 Hz, 100 VA

TTR330-47

Included Accessories
Canvas carrying bag for test leads

30915-211

Power supply cord, 8 ft (2.5 m)

17032-4

Ground lead, 15 ft (4.6 m)

4702-7

Test Leads
For 3-phase connections, shielded, clamp-end terminated
H winding, 10 ft (3.1 m)

30915-509

X winding, 10 ft (3.1 m)

30915-508

Extensions, shielded
H winding, 33 ft (10 m)

30915-501

X winding, 33 ft (10 m)

30915-500

Hand-held switch assembly for LTC remote control testing

30915-220

PowerDB Lite Software
Ethernet cable for connecting to a PC

36798

Bushing clamps (6 pcs)

MC7144

Transformer Vector Voltage Diagrams
ANSI Standards

35298

IEC Standards

35299

AS (Australian) Standards

35300
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Table 7-1. Replacement Parts List cont’d

Item

Cat. No.

Optional Accessories
Calibration Standard (for Operation Check)

550555

Inverter with 3 ft (0.91 m) cigarette adapter cord:
12 V dc to 120 V ac, 60 Hz

35271-1

12 V dc to 120 V ac, 50 Hz

35271-3

12 V dc to 230 V ac, 60 Hz

35271-2

12 V dc to 230 V ac, 50 Hz

35271-4

Test Leads
For 1-phase connections, shielded, clamp-end terminated
H winding, 10 ft (3.1 m)

30915-528

X winding, 10 ft (3.1 m)

30915-529

For 3-phase connections, shielded, clamp-end terminated
H winding, 20 ft (6.2 m)

30915-530

X winding, 20 ft (6.2m)

30915-531

Transit case for instrument leads and accessories

37009
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Specifications
Electrical
Input Power
Cat. No. TTR330:

120 V ac ±10%, single phase, sine, 50 ±2 Hz or 60 ±2
Hz, 100 VA, IEC 1010-1 installation category II

Cat. No. TTR330-47:

230 V ac ±10%, single phase, sine, 50 ±2 Hz or 60 ±2
Hz, 100 VA, IEC 1010-1 installation category II

Protective Devices
Fuses (2)*:
Cat. No. TTR330:

Type T, 250 V, 3.5A (IEC 127 designation)

Cat. No. TTR330-47:

Type T, 250 V, 1.5 A (IEC 127 designation)

High voltage and low voltage measurement circuit shorting relays
Heavy duty varistors, transient voltage suppressors, and gas surge voltage
protectors
* Two spare fuses are included with each TTR as spare parts

Output Test Voltage and Current
3 test voltages:

80 V rms, 40 V rms, 8 V rms.

Current:

up to 500 mA
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Test Frequency
Same as line frequency.

Loading of Test Transformer
Less than 0.2 VA

Measuring Ranges
Turn ratio:

80 V ac: 0.8 to 45,000, 5 digit resolution
40 V ac: 0.8 to 25,000, 5 digit resolution
8V ac: 0.8 to 8,000, 5 digit resolution

Excitation Current:

0 to 500 mA, 3 digit resolution

Phase Angle
Deviation:

± 90 degrees, 1 decimal point for the minutes display, 2
decimal point for the degree display, 2 decimal points
for the centiradian display

Accuracy
Turn ratio:
80 V ac:

±0.1% (0.8 to 2000)
±0.15% (2001 to 4000)
±0.25% (4001 to 10000)
±0.3% (10001 to 45000)
±0.1% (0.8 to 2000)

40 V ac:

±0.15% (2001 to 4000)
±0.3% (4001 to 10000)
±0.35% (10001 to 25000)
±0.1% (0.8 to 2000)

8 V ac:

±0.25% (2001 to 4000)
±0.35% (4001 to 8000)
Excitation Current (rms):

±(2% of reading + 1 digit)

Phase Angle Deviation:

±3 minutes
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Measurement Method
In accordance with ANSI/IEEE C57.12.90

Transformer Winding Phase Relationship
ANSI C57.12.70-1990
CEI/IEC 76-1:1993 and Publication 616:1978
AS-2374, Part 4-1997 (Australian Standard)

Measuring Time
10 to 20 seconds depending on mode of operation and type of transformer

Display
8.4 inch, full VGA color display

Memory Storage
Internal and USB memory device: Over 1000 test results (depending on size)

Interface
Ethernet
USB (as host), qty=2

Environmental Conditions
Operating temperature range:

23° to 122°F (-5 to 50°C)

Storage temperature range:

-58° to 140°F (-50 to 60°C)

Relative humidity:

0 to 90% noncondensing (operating)
0 to 95% noncondensing (storage)

Physical Data
Dimensions:

21.5 x 13.5 x 8.5 in. (44.5 x 26.5 x 17.5 cm) (L x W x H)

Weight (test set):

25 lbs. (11.5 kg)

Case:

Ruggedized plastic case with removable lid and carrying
strap
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Addendum A
TTR 300 Series PowerDB Lite User Manual
Introduction
PowerDB Lite is a free, but limited capability, version of the PowerDB software
tool that is designed specifically to control and/or extract data from Megger
instruments. The primary difference between PowerDB Lite and PowerDB is
that PowerDB is designed to work with all manufacturers’ equipment and has
field and office synchronization capabilities. PowerDB Lite will present your test
data into a professional looking data form that can be sent to a printer or .pdf file
distiller such as PDF995.
PowerDB Lite allows you to use a sub-set of the standard PowerDB forms that
are appropriate for specific Megger instruments. PowerDB Lite detects the
instrument and enables the appropriate form(s). Data can be entered on-screen
or captured directly while using the test instrument. Completed data forms can
be saved as files to your computer.
Minimum Recommended System


Operating System: Windows 2000 or later



RAM: 64 MB RAM minimum, 512+ MB RAM recommended



Processor: 300 MHz Pentium Class processor minimum, 1 GHZ or better
recommended

For information about the features of the full version of PowerDB please visit
our website at www.powerdb.com. Get acquainted with the following features
by scheduling a live demonstration at info@powerdb.com


Synchronize All of Your Test Records Into a Single Corporate



Reduce Test Time



Improve Data Integrity



Standardize Test Procedures



Easily Use Historical Trending for Evaluation of Test Results
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Eliminates the Need to Install and Maintain a Software Application per
Instrument



Eliminates All Hand Written Test Sheets



Create Your Own Test Forms



Use or Modify One of Our 200 Built-in Test Forms



One Step Procedure To Generate Test Reports With Table of
and Deficiency Summaries



Allows All Of Your Field Test Data To Be Integrated With CMMS Systems
Such As Maximo or SAP



Imports >From Many Other Industry Standard Software Applications



Controls and Imports Data From Many non-Megger Instruments
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Software Installation
To install PowerDB Lite, load the PowerDB Lite CD into your CD-ROM drive
and follow the on-screen instructions.
1. Accept the terms of the License agreement.

2. Choose the destination location for the PowerDB Lite files.
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3. Select Default Settings.

4. InstallShield Wizard will complete the installation of PowerDB Lite. Click
Finish to close the installation program.
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Using PowerDB Lite
1. Home
1.

Select your Instrument from the Instrument Setup screen.
a. You can always view the Instrument Setup screen from the Tools
menu or F3.
b. Select the appropriate row in the Description column.
Then click the “...” button in the Setup column.

c. The TTR 300/310 only uses serial communicate, so never check ‘Use
Ethernet’ if you are using a TTR 300 or TTR 310. Select the
appropriate communication settings on the Serial Device
Configuration screen. Use the Refresh button to find any ports that
may have not been connected at the startup of PowerDB Lite. If you
are using a USB serial port and do not know the port assigned to it
please perform the following:
1. Remove the USB serial adapter
2. Press Refresh
3. Click on the port drop down and record the options
4. Plug the adapter back in
5. Press refresh
6. Select the port that was not in the original list
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Verify that the baud rate is set to 9600, Parity is set to none, Byte Size is set to 8,
and Stop Bits is set to 1.
d. Only check ‘Use Ethernet’ if connected to the TTR330. If you leave
the IP address blank PowerDB Lite will discover the unit. If you
have problems with the discovery enter the IP address which is
displayed on the instrument’s Preferences screen.

e. Then Click OK on the Instrument Setup Screen to finish.

2. Open a New Form
a. Select the File>New menu item, or type CTRL+N, or press the New
toolbar button.
b. The forms associated with the detected instrument will be shown in
the Select a Form screen.
c. Choose a form by double-clicking or by navigating with the arrow
keys and pressing the OK key.
d. See Specific Form Help Instructions for further instruction on test
steps. You can view the Form Help by pressing the F1 key once the
form is loaded.
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3. Enter Test Data
a. Header and nameplate information can be manually typed into a
form.
b. Click the Initialize Instrument button

to initialize the test set.

c. Form fields with automation will now be colored cyan. Right-clicking
these fields will start the test.
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d. To change the settings of the TTR place the mouse on the form and
right-click. Then select “TTR Settings”.

e. This dialog box allows you to change the TTR settings. The settings
that can be changed are as follows:
1. Show Diagram Number
When enabled this will display a numeric field below the
winding configuration diagram on the form. The diagram
can then be changed by entering a number in this field.
2. Standard
This enables you to choose between the ANSI, Australian, or
IEC Standard.
3. Test Voltage
This enables you to choose the test voltage at which the test
is run. Auto allows the instrument to choose an acceptable
test voltage for testing. You may choose between Auto, 8,
40, or 80.

4. Running an Automated Test
a. Select the Initialize Instrument button.
b. Automated fields should now turn cyan colored.
c. Right-click on the cyan colored fields.
d. Follow the on screen instructions specific to the test.
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5. Comments and Deficiencies
When imported into the full version of PowerDB, the comments and
deficiencies on each form are used to generate summary reports. These
summary reports repeat the notations and lists the page number where reported.
This allows the user to scroll to a particular page to view a reported anomaly.
For more information on features of PowerDB visit us at our website at
www.PowerDB.com.

6. Save the Data
a. Select the File>Save menu item, or press CTRL+S, or press the Save
toolbar button.
b. The Save As screen will allow you to specify a location and file name
for your PowerDB Lite XML file.
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7. Opening an Existing File
a. Select the File> Open menu item.

b. Browse to the file you would like to open.
c. Press the Open dialog button.
d. If the file contains multiple test dates, select the date that you would
like to open for editing or select New to append a new set of results
to the file. To remove a set of results, click on the selected file and
press the delete button.

AVTMTTR300 Rev B Sept 2008

52

TTR Series PowerDB Lite User Manual

8. Loading Data Files
When testing with the TTR 320 or TTR 330 you may load files saved on the
instrument’s USB drive. Refer to Step 7 for instructions on selecting and
opening files.

9. Setting the Logos
a. Select the Tools>Options menu item.
b. The Logos section specifies paths to the left and right logos files to
use.
c. To change the left logo press the “…” button by the left logo path.
d. The Open screen allows you to browse to a file location, select a
.JPG or .BMP file, and press the Open button.
e. Repeat steps (c) and (d) for the right logo path.
f. Note that a logo will not be shown if the logo file path is blank or the
file does not exist.
g. Note after specifying the logo files the image will not be shown until
the next time a form is opened (File>Open, or the File>New menu
items).
h. Note that the logos will look the best if the resolution of the file is
pixels wide by 240 pixels high. DPI is not important.
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10. How to change Languages
a. Select the Tools>Options menu item.
b. Select the appropriate language in the dropdown menu.

11. How to change units of measurement
a. Select the Tools> Options menu item.
b.

Select the units in the drop down Default Units under Measurements

.

AVTMTTR300 Rev B Sept 2008

54

TTR Series PowerDB Lite User Manual

12. Additional Notes
a. Additional forms can be filled out by repeating steps 2, 3 and 6.
b. Forms can be printed with the File>Print menu item, or type
CTRL+P, or press the Print toolbar button.
c. A help guide may be found in the Help>PowerDB Lite Help menu
item.

Frequently Asked Questions (FAQ’s)
1. Can I change the forms?
No. You must have the full version of PowerDB to change forms.
2. Can I synchronize forms to a database?
No. You must have the full version of PowerDB for database support and to
synchronize multiple field databases to a single master database.
3. Can I import PowerDB Lite files into PowerDB?
Yes. You can use the File>Import menu item in PowerDB to import files from
PowerDB Lite.
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Specific Form Help Instructions
Operating Instructions for the Multiple Quick Test Form
a. Type in the asset ID and then press the Enter key.
b. Use the left and right arrow keys to select the high-side winding
configuration.
c. Press the Enter or Tab key.
d. Use the left and right arrow keys to select the low-side winding
configuration
e. Press the Enter or Tab key.
f. Select the test voltage from the dropdown menu, then press Enter or
Tab.
g. Type in the high side tap number and press the Enter key.
h. Type in the high side voltage and press the Enter key.
i.

Type in the low side tap number and press the Enter key.

j.

Type in the low side voltage and press the TEST key (F2) or right
click on the blue highlighted fields.

k. Hit the Enter key and repeat for each tap you would like to test.
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Operating Instructions for the Simple 3PH TTR Form
This form can be used for testing a two or three winding transformer with
multiple taps on one or more of the windings.
If you are testing a three winding transformer please check the “Has Tertiary”
checkbox.
Next select the winding configuration by using the left and right arrow keys.
Press the Enter or Tab key to move to the next field.
The default total number of tests is defined as follows:
1. Test for each secondary (or tertiary) tap tested with the primary nominal tap.
2. Test for each primary tap with the nominal secondary (or tertiary) tap.
If you do not wish to test all of the secondary or tertiary taps you can reduce the
“# tests” field for each category of tests (primary, secondary, tertiary).
Once the total number of taps and the # tests field are entered the form will
display the correct number of rows to perform testing.
Once the voltage is entered for the first and last tap values (from the
transformer’s nameplate tap voltage table), the ratios for all taps will
automatically be calculated and populated. Please note that the calculated values
can be over written.
Right click on each of the blue highlighted fields in each table to run the tests.
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Operating Instructions for the 3PH TTR with TAP Changer Form
The procedure for this form is the same as the Simple TTR form. The only
difference is that it allows the user to enter additional nameplate information.
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